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Software Usage Agreement  
Silhouette America Corporation ("Silhouette America") hereby grants the 

purchaser and authorized User (the "User") the right to use the software (the 

ñSoftwareò) in accordance with the terms and conditions specified. By its 

purchase and/or use of the Software, the User hereby accepts and agrees to 

abide by the terms and conditions set forth herein. 

1. Copyrights 

All copyrights relating to the Software and accompanying printed materials 

such as manuals shall be retained by the individuals or organizations 

indicated in the Software or printed material. 

2. License 

The User may use the Software on one computer at a time. 

3. Copying and modification 

(1) The User may copy the Software for backup purposes.  

(2) The User may not modify, combine, amend, or otherwise adapt the 

Software by any means, including disassembly and decompiling. 

4. Third-party use 

The User may not transfer, assign, or otherwise dispose of the rights 

relating to the Software or its use to third parties. 

5. Warranty 

(1) Should the Software not operate correctly due to physical defects in the 

Software installation CD, contact Silhouette America. The Software CD 

will be exchanged in the case of a physical manufacturing defect, or a link 

to download the software will alternately be provided at Silhouette 

Americaôs discretion. 

(2) Silhouette America only guarantees the CD under the above situation. 

(3) Silhouette America provides the Software on an ñas isò basis. Neither 

Silhouette America nor the supplier guarantees the performance or results 

that may be achieved using the Software and accompanying documentation. 

Neither Silhouette America nor the supplier gives any explicit or implicit 

guarantees regarding the infringement of a third party's rights arising from 

the use of the Software or accompanying manuals, their commercial 

performance, or their suitability for specific purposes. Neither Silhouette 

America nor the supplier assumes any responsibility for incidental, 

secondary, or special damages resulting from the use of the Software or 

accompanying manuals under any circumstances, including cases in which 

the possibility of that particular damage arising is indicated to the User by 

the retailer. Moreover, neither Silhouette America nor the supplier assumes 

any responsibility for claims from third parties. 

Registered Trademarks  
The company names and product names described in this manual are 

registered trademarks of their respective owners. 

Disclaimer  
Some of the software images used in this manual are those that were used 

when the software was under development, and they may be slightly 

different from those actually displayed. There are no differences between 

the functions and setting layouts shown here and those of the actual version.  

About this Manual  
This manual is intended to provide an overview on how to use the 

Silhouette Studio software.  While other cutting devices may be compatible, 

this manual assumes the use of the Silhouette or Silhouette SD digital 

cutting units.  Instructions on using the Silhouette cutting unit may be found 

in subsequent manuals regarding the  Silhouette hardware itself, including 

instructions on setting up the Silhouette for cutting or sketching, loading 

materials, and using the SD card feature (Silhouette SD model only) to cut 

directly from the Silhouette hardware device. 

(1) The contents of this manual may not be copied in part or in whole 

without permission. 

(2) The details and product specifications in this manual are subject to 

change without notice. 

(3) The greatest effort has been taken to ensure the clarity and accuracy of 

the information in this manual. Please contact Silhouette America or your 

retailer with any questions you may have. 

(4) Please note that Silhouette America assumes no responsibility for any 

liabilities arising out of the use of this manual and product. 
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1. General Information  
Silhouette Studio is drawing/editing/output software that enables the 

creation of outline and print data consisting of objects and text, and the 

output of the created data to the Silhouette Digital Craft Cutter for a variety 

of applications including cutting and perforating media materials for 2-

dimensional projects, fabricating 3-dimensional fold-together models from 

cut-out templates, and sketching line art.  The software is compatible with 

all Silhouette models.  The software also interfaces with other Graphtec 

plotter models CC100 ï CC300 series models.  Features and cutting results 

cannot be guaranteed for compatible plotter units or digital cutting units not 

offered by Silhouette America.  Some features, such as Print & Cut 

applications, may not be available for other compatible cutting units not 

offered by Silhouette America.  Silhouette Studio also supports convenient 

functions that enable the capturing of image data into the software and the 

automatic creation of registration marks for Print & Cut applications. 

1.1 System Requirement s 
The following system environment is required to use Silhouette Studio. 

Operating System:   

Windows ïXP/Vista/7 (32-bit & 64-bit)  

Mac ï OS X 10.5.8 or later 

CPU: Pentium III 800 MHz or higher 

Memory: 1GB RAM recommended 

Monitor : 1024 x 768 True-color recommended (compact button mode 

available for notebook computers) 

Mouse and/or Graphic Tablet 

CD-ROM drive (for installation) 

Supported cutting unit: Silhouette (original), Silhouette SD, Silhouette 

Cameo, Craft ROBO, and Graphtec models (CC100, CC200, CC300/CC330, 

CC300L/CC330L) 

Supported printers: Windows-compatible or Mac-compatible printers 

(inkjet printers strongly recommended for Print & Cut applications)  

 

 

1.2 Features Overview  
The Silhouette Studio software includes, but is not limited to, the following 

software features and benefits: 

¶ Imports a variety of file formats 

¶ Print & Cut technology (requires printer) 

¶ Download exclusive digital content 

¶ Organize and optimize the library collection of images 

¶ Cut TTF (True Type Font) files already installed on your computer 

¶ Manipulate Text with: 

o Word and letter wrapping 

o Alignment justification 

o Letter spacing control 

o Fit text to path 

¶ Draw your own images in printing and cutting formats, including 

o Lines 

o Circles, Squares, and Rounded Rectangles 

o Polygons & Curved lines 

o Free-hand drawing tool 

¶ Resize images to exact specifications 

¶ Un-group/Group sets of lines for manipulation 

¶ Edit and manipulate points of text and  images 

¶ Erase image parts with freehand eraser tool 

¶ Weld images together 

¶ Create shadowed mat effects 

¶ Arrange images with following abilities: 

o Transform 

o Rotate 

o Align 

o Replicate 

o Modify 

¶ Manipulate line types for differing cutting actions 

¶ Create your own Print & Cut images by filling images with custom 

colors, gradients, pattern fills 

¶ Unlimited ñUndoò and ñRedoò actions 
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1.3 Software File Formats  
The Silhouette Studio software uses a proprietary .STUDIO file format, 

which consist of vector art for line and color/gradient fill type data intended 

for printing and/or cutting.  The Silhouette also is able to open
*
 the 

following vector file formats in a Ready to Cut format: 
 

¶ GSD/GST (ROBO Master program files) 

¶ DXF 
 
The Silhouette Studio software can also import some other vector and raster 

file formats for the purpose of being able to trace these images to create cut 

lines for Print and Cut images. The following additional file types can be 

imported: 
 

¶ JPG 

¶ BMP 

¶ PNG 

¶ GIF 

¶ WMF 
 
In addition to files that may be opened or imported, Silhouette Studio can 

also access font files in TTF (True Type Font) format.  Please note that 

Silhouette America cannot guarantee the quality or success of fonts not 

offered by our company as not all fonts are designed with cutting or 

sketching in mind. 

 

You are also able to create your own images to cut with the Silhouette 

software. There are simple line drawing functions built into the Silhouette 

software that will allow you to do so from within the Silhouette program. 

 
*Not all features of these file types may be able to be imported into the Silhouette Studio 

software.   

  

 

1.4 Available Digital Content  
The Silhouette Studio software comes pre-loaded with 50 ready-made 

designs.  These are immediately available by accessing your library. 

 

 
 

Additional content is available through the Silhouette Online Store 

(accessed through the Silhouette Studio software).  The online store will 

allow you to access and purchase additional digital content for the software, 

available both from Silhouette America artists as well as independent artists 

and various companies, thus ensuring a variety in look and feel of available 

pre-made content.   Further information on the store and downloading 

content will be provided later in this manual. 
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2. Installing Silhouette Studio  

2.1 Installing on PC  
1. Insert the installation CD into your computerôs CD-ROM drive.  

 

2.  Windows Vista and Windows 7 users: You may need to allow 

permission to run the installer program that is automatically launched, or 

select to Run SilhouetteInstaller.exe if given the option to do so. 

 

3. When the installer is launched, click Next proceed. 

 

4. The license agreement will then be displayed.  Carefully read and review 

the information provided and then click on Yes to continue the installation 

process. 

 

5. Continue to follow the prompts to install to the desired directory and 

complete the installation process. 

NOTE FOR WINDOWS USERS ONLY:  Upon hooking up the USB cord from 

the Silhouette tool to your computer and powering on the Silhouette unit, 

you may be prompted with a ñNew Hardware Wizardò to install a driver.  

You may proceed to automatically find and install the driver as located on 

the installation CD.   The driver is not required for proper operation of the 

Silhouette Studio software, but may be installed to resolve the Windows 

automatic ñPlug and Playò feature of prompting to install a driver for the 

hardware whenever the Silhouette is powered on. 

 

 

 

 

 

2.2 Installing on Mac  
1. Insert the installation CD into your computerôs disc drive. 

2. Drag and drop the Silhouette Studio program into your Application folder 

to launch the installation process. 

3. As the program is initially launched, the license agreement will be 

displayed.  Carefully read and review the information provided and then 

click on Yes to continue to complete the installation process. 
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3. Basic Software Overview  

3.1 Opening the Software  
To open the software on PC, locate the desktop icon and double-click, or if 

one was opted be created during installation, go to the Windows Start menu 

and select to run Silhouette Studio. 

 

To open the software on Mac, open the Applications folder and launch 

Silhouette Studio.   

 

The Silhouette Studio icon will appear as follows: 

 
 

Once opened, the software should show an available starting document and 

workspace as shown below: 

 

3.2 Software Sections 
The software offers several sectioned areas.  Details as to each buttonôs 

specific function are discussed in later sections.  However, so that you may 

be familiarized with where everything is located, a brief overview is 

provided for each of the sections. 

 

General Document Management 

 
This section along the top left-hand side of the screen is for general 

document management functions, such as opening, saving, and sending 

documents to a printer or your Silhouette digital cutting unit. 

 

Standard Editing Tools 

 
This section along the top left-hand side of the screen is for basic 

copy/paste/cut and undo/redo actions commonly found in many programs. 

 

Zooming Tools 

 
This section along the top left-hand side of the screen is for basic zoom-in 

or zoom-out functions to view parts of the document from a closer 

perspective or at a more distant range. 
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Silhouette Studio Tools 

 

 
This section along the top right-hand side of the screen provides a range of 

tools for filling images, altering lines, adjusting text attributes, adjusting and 

replicating images, and adjusting page and cutting conditions  . 

 

Drawing Tools 

 

  

 

This section along the left-hand side of the screen provides 

tools used for selecting, and drawing images as well as the 

ability to drop text directly into your workspace area. 

 

 

 

 
 

 

 

Library and Store Tools 

 

This section along the left-hand side of the screen provides 

tools used for accessing the library and online store section. 

Image Manipulation Tools 

 
This section along the bottom of the screen provides a range of tools for 

grouping and selecting images, duplicating and deleting items, image 

placement priority (such as bringing images to the forefront or sending them 

to the back behind other images), welding, and offsetting. 

3.3 Cutting/Drawing Area  
You will note there are two different sections in your workspace: 

 

¶ White workspace 

¶ Grey holding area 

 
The white workspace notes the active document area.  Images may be 

placed or drawn onto this area, or they may be placed or drawn in the grey 

holding area.  Any images in this grey area are invisible to your cutting unit 

or printer.  You may wish to place images off to the side to be set aside as 

you do not wish to include them in your job to be printed and/or cut. 

  

You will note a red border inside this white workspace.  The red line 

represents the active cutting area.  The cutting unit will only be able to see 

and be able to cut what is inside this red line.  All images being sent to the 

Silhouette to cut should be within this red line area. 
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3.4 Opening Documents  
Though opening the software will always provide you with a new 

document, you may select a new workspace to start a new project at any 

time. To start a new document you may either use the New option from the 

File menu, or select the New icon: 

 
To open existing files you may either use the Open option from the File 

menu, or select the Open icon: 

 
You will then be prompted to navigate to the location where your desired 

file is located.  Through the Open feature, the Silhouette Studio software 

has the ability to open the following cutting-type files: 

¶ STUDIO (Silhouette Studio files) 

¶ GSD/GST (Graphtec ñROBO Masterò program files) 

¶ DXF 
*
 

 
* 

Silhouette Studio supports the following DXF features only:  Arc, Circle, Ellipse, Line, 

DWPolyline, Spline, and Text 

 

The Open feature can also access simple image file types that are not in 

cutting format, but may be imported for printing or tracing purposes.  When 

using a PC, you will need to select ñAll Filesò under the type of file as you 

seek to open another type of file format. 

 

A list of recently used documents may also be accessed from the File menu 

under Open Recent. 

 

You may also use the Merge option from the File menu to open any file into 

the same workspace you are using rather than opening a new document 

workspace. 

 

Finally, compatible file types may also be accessed by dragging the saved 

file from your computer directly onto your workspace in the software. 

3.5 Document Tabs  
Each new document or opened document will provide you with a new 

document tab at the bottom left hand corner of your screen. 

 
The tab will be labeled as ñUntitledò until you save your file with a name, 

or if you have opened a file that already had a name, in which case the fileôs 

name will be displayed.  The white tab will always be the active document 

while all other opened inactive documents will be grey.  You may click on 

any inactive tabs to make it the active workspace and toggle between open 

documents.  Clicking on the ñXò will close any open workspace. 

3.6 Document Sizes 
When a new document is opened, the default document size will always 

start at a standard Letter size (8 İò x 11ò) for the original Silhouette and 

Silhouette SD models or a 12ò x 12ò size for the Silhouette Cameo model. 

 

To adjust your document size to another setting, you may either use the 

Page Tools option from the View menu, or select the Page Tools icon: 

  
The Page Tools will allow you to alter the width or length of your 

document.  There are pre-set common sizes you may select, or you may set 
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measurements manually for any custom page sizes of material you may 

wish to use. 

 

With custom page sizes the width may be adjusted up to a maximum 8 ½ 

inch material width (original Silhouette and Silhouette SD) or a 12 inch 

width (Silhouette Cameo) depending on the cutting model used.  The 

minimum recommended width for a custom size is 3 inches.  The height 

may be adjusted up to any desired measurement.  However, the maximum 

recommended height is 40 inches.  While longer materials ranges may be 

selected, lengths exceeding 40 inches may have the possibility of becoming 

misaligned on the Silhouette machineôs rollers as the cutting process 

continues beyond this maximum recommendation.  The minimum 

recommended height for a custom size is 3 inches. 

 

While viewing the Page Settings menu, if your material is sized to fit onto 

the cutting mat, the cutting mat will be displayed to help you see how your 

material may be placed onto the cutting mat to feed into the Silhouette when 

it is time to cut.  Later, as you go to cut, this will also be displayed to help 

ensure you are feeding your material into the Silhouette correctly.  This 

cutting mat animation may be selected to always be displayed under the 

Preferences settings (discussed in section 3.9). 

 

When the cutting mat is shown, you may select the Reveal Cutting mat 

option in the Page Settings menu in order to show exactly on your mat 

where images will be cut in reference to the grid that is printed on the actual 

cutting mat. 

 
As you slide the bar to the right or increase the percentage number, the 

white page workspace will become more transparent and show the cutting 

mat beneath.  A setting of 100%, or having this bar slid all the way to the 

right, will allow you to see the cutting mat completely and your white 

workspace will be entirely transparent.  

 
When viewing in this manner, the red line will still represent your cutting 

area.  Images falling outside of this red cutting area will not be cut.  The 

darker area on the cutting mat represents your printerôs print margin area 

and is only for reference. 
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3.7 Cuttin g Orientation  
Documents may be viewed in Landscape or Portrait orientation.  Depending 

on how you may wish to view your workspace, images being sent to the 

Silhouette will vary based on your orientation. 

Landscape is the default orientation whenever a new document is opened.

 
When a document is in landscape orientation, it will be sent to the 

Silhouette with the upper left-hand corner of the screen coinciding with the 

upper right-hand side of your material, as seen below: 

 

Portrait orientation is an optional orientation that may be switched to 

through the Page Tools.  Using this orientation will provide you with a 

screen that appears as the following: 

 

 
When a document is in portrait orientation, it will be sent to the Silhouette 

with the upper right-hand corner of the screen matching the upper-right 

hand side of your material, as seen below: 
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The Page Tools also provides the ability to rotate how you are viewing your 

page.  While the Page Orientation will dictate the way your cutting job is 

being sent to the Silhouette to cut, the Rotate View option will simply rotate 

your workspace on the screen for a different perspective. 

3.8 Viewing and Zooming  
Often as you view your workspace, you may either wish to zoom in to get a 

closer look at smaller images or parts of an image that may be more 

difficult to work with. 

 

Zoom In 

 
This tool will zoom into the center of your workspace for a closer view. 

 

Zoom Out 

 
This tool will zoom out from your view for a more broad perspective. 

 

Selection Zoom 

 
This tool will allow you to zoom to specific areas of your workspace by 

drawing a box around the area you wish to zoom into. 

 

 

 

Drag Zoom 

 
After clicking on this tool, your icon will appear as the Drag Zoom icon 

above.  You may then click and hold down your mouse to zoom in or out 

manually to any selected scale. 

 

Fit to Page 

 
Clicking the Fit to Page icon will immediately fit the full defined workspace 

to the center of your screen. 

3.9 Preferences  
There are a number of user-controlled options that may be found in the File 

menu (PC) or Silhouette Studio menu (Mac) under Preferences.   

 

Display 

This section provides display options including:  

¶ Antialiasing ï Helps smooth jagged lines as they are created and 

viewed.  Higher sample rates will increase the smoothness of lines.  

The ñoffò setting will produce rougher edges, but increases 

drawing speed. 

¶ Button sizing & User Interface ï Allows for larger or smaller 

display preferences for varying screen resolution sizes.  

¶ Animation ï Controls speed of animating actions, such as images 

being moved on undo or redo actions, or during zooming in and 

out.  Can be adjusted to ñInstantò to turn animations off. 

¶ Background Color Preference ï Allows you to determine the color 

of the inactive workspace area. 
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Measurements 

This section provides preferences regarding units of measurement displayed 

in the program.  You may adjust the following: 

¶ Unit of Length ï Adjust all displayed measurements to desired 

unit. 

¶ Dimensions ï Turn on or off imageôs measurement properties as 

images are selected. 

 

Selection 

This section provides preferences for adjusting how the program selects 

images or how various drawing tools either continue to draw or finish upon 

completion of using the drawing tools. 

 

Editing 

This section provides preferences for how you may wish to view bezier 

control handles and how you would like images to behave when certain 

modifications are applied. 

 

Default 

This section will allow you to adjust the default settings when Silhouette 

Studio software is opened.  You may adjust the following settings: 

¶ Default Fill Style ï Provides the ability to select how new user-

drawn images are created as to whether they are displayed as an 

outline only (as red line images or grey line image), or as solid fill 

images (which may be preferable for the creation of Print & Cut 

images that are made by the user). 

¶ Cutting Mat Display Preference ï Provides the ability to always 

show the cutting mat or only when sending images to cut. 

¶ Registration Marks Preference ï Adjusts the program to default to 

have registration marks turned on or off. 

¶ Page Configuration ï Define whether Landscape or Portrait 

orientation is desired whenever a new document is started. 

¶ Cut Area ï Defines cutting area based on the model being used.  

 

General 

This section allows you to manually select the program language and how 

often you may wish the program to check for available software updates 

automatically.   

 

Advanced 

This section provides additional advanced options.  In this section, you may 

adjust the following: 

¶ HTTP Sockets ï Depending on your internet connection speed, this 

option may be adjusted to a higher number of sockets to increase 

the download speed when purchasing images from the online store. 

¶ Reindex My Library ïPerforming this action will re-index the 

library to ensure corruption or errors may be resolved should you 

experience any concerns with your library loading properly or 

being able to use the libraryôs Search function properly. 

¶ Reset Library ï This action will remove all images and folders 

from your library and reset the library back to its original software 

installation settings. 

¶ Image Threshold ï This option determines how your computerôs 

video card handles larger raster images in the program.  

 

Another program option not in the Preferences menu is the Software Color 

Theme button located in the bottom right-hand corner of the software 

screen. 

 
Clicking on this button will cycle through a pre-selected list of color themes 

for the softwareôs overall appearance, should you prefer some color other 

than the default dark grey interface.  Right-clicking on this icon will allow 

you determine the color scheme of the inactive area around your workspace. 
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4. Drawing/Editing Images  

4.1 Basic Drawing Tools  
Silhouette Studio allows users to draw and create images very easily 

through a set of basic drawing tools.  All drawing tools are located on the 

left side of the software screen. 

Line Tool 

 
The Line Tool allows for the creation of single straight lines.  Holding down 

the Shift key on your keyboard while drawing will force a straight vertical, 

horizontal, or 45-degree increment line from the start point. 

 

Rectangle Tool 

 
The Rectangle Tool allows for the creation of a square or rectangle.  Holding 

down the Shift key on your keyboard while drawing will create a square, 

while holding down the Alt key on your keyboard will make the initial 

cursor point where your image is started as the exact center of your object. 

 

Rounded Rectangle Tool 

 
The Rounded Rectangle Tool allows for the creation of a square or rectangle 

with rounded corners.  Holding down the Shift key on your keyboard while 

drawing will create a rounded square, while holding down the Alt key on 

your keyboard will make the initial cursor point where your image is started 

as the exact center of your object.  As a rounded rectangle is selected, you 

will find two red control points on the rectangleôs upper left-hand corner.  

These may be dragged to adjust the curves of the rectangleôs top and bottom 

or sides, or you may select both simultaneously by holding down the Shift 

key on your keyboard and dragging one of the control points. 

 

Circle Tool 

 
The Circle Tool allows for the creation of an oval or circle.  Holding down 

the Shift key on your keyboard while drawing will create a circle, while 

holding down the Alt key on your keyboard will make the initial cursor 

point where your image is started as the exact center of your object. 

 

Polygon Tool 

 
The Polygon Tool allows for the creation of multiple straight lines.  A point 

will be created upon each mouse click.  Lines will continue to be drawn 

until the image is closed by aligning the end point with the starting point, or 

by double-clicking the mouse to stop drawing.  Holding down the Shift key 

on your keyboard while drawing will force a straight vertical, horizontal, or 

45-degree increment line from the start point or last point dropped. 
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Curved Shape Tool 

 
The Curved Shape Tool allows for the creation of multiple curved lines.  A 

point will be created upon each mouse click.  Lines will continue to be 

drawn until the image is closed by aligning the end point with the starting 

point, or by double-clicking the mouse to stop drawing. 

 

Freehand Drawing Tool 

 
The Freehand Drawing Tool allows for the creation of a continuous free-form 

line.  Lines drawn with this tool will continue until the mouse button is 

released, or the image is closed by aligning the end point with the start 

point.  
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4.2 Editing Images  
All line points on images may be edited, if changes to the existing image are 

desired.   

 

Select Tool 

 
The Select Tool determines which image is selected as the active image and 

allows you to move images around on your screen.  This is your default tool 

to click on images to show they are selected. 

 

Edit Points 

 
To enter the Point Editing Mode, you may either double-click on a selected 

image, or use the Edit Points tool.  This tool will allow you to edit any 

points of your image to move them around or remove them.  Only single 

ungrouped line selections may be edited.  Ungrouping will be discussed in 

later sections. 

 

To exit the Point Editing Mode, you may double-click on your image again, 

or return to the regular select mode by clicking on the Select tool. 

 

Point Editing Mode 

When you enter the Point Editing Mode, selected images will change from 

displaying the resizing and rotating control handles around the image to 

showing the points, or nodes, of the image.  Points on lines are where the 

line may take a new direction or change from being flat (or straight) to 

being curved. 

 

 

 

 

 

 

 

 

 

                      

                     Regular Selection Mode      Point Editing Mode 

 

In Point Editing Mode, the selected point will be displayed in white while all 

other points will be dark grey.  The selected line associated with the 

selected point will be emphasized as a bolded red line.  Additional lines that 

have blue points are handles to adjust curved lines. 

 

In Point Editing Mode, you will also be shown the Point Editing toolbar on the 

right-hand side of the screen.  You may do the following actions in Point 

Editing Mode: 

 

Move/Adjust Points 

Move a point by hovering with your mouse over any point on the line.  

Once over a point that may be edited, the cursor will adjust to show you 

may click and grab the point to move it to any desired location.  With 

curved lines, you may similarly grab the blue points and drag them around 

the screen to adjust the curve of the associated line segment. 

 

Add Points 

Add a point by hovering over the line where no points currently exist where 

you may wish to drop a new point to edit your image.  Once over a line 

where a point may be dropped, the cursor will be adjusted to show you may 

click to drop a point onto the desired line location. 
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Delete Point 

 
Any selected point will be deleted by using the Delete Point tool, or by right 

clicking on the selected point and choosing the Delete Point option.  

Deleting a point will cause the closest points on either side of the deleted 

point to join and create a new connecting line.  Note that this tool is 

different from deleting an image and is only intended to delete individual 

points.  It will only be available while in Point Editing Mode. 

 

Break Path 

 
You may break the path of any line point by using the Break Path tool, or by 

right clicking on the selected point and choosing the Break Path option.  

Breaking a path will create two new points from the originally selected 

point where the path was broken. 

 

You will note that a broken path, or two unconnected end points of opposite 

ends of the same line, may be re-joined by dragging one end point onto the 

opposite end point of the image. 

 

Corner 

 
The Corner tool will allow a selected point to be so that the control handles 

at the selected intersecting point can be adjusted each individually to create 

a sharp corner. 

 

Smooth 

 
The Smooth tool will allow a selected point to be adjusted to make a smooth 

transition point at the selected intersecting point. 

 

Make Flat 

 
The Make Flat option will adjust the selected line (the line emphasized in 

bold red that is associated with whichever currently selected point) to a flat, 

straight line. 

 

Make Curve 

 
The Make Curve option will adjust the selected line (the line emphasized in 

bold red that is associated with whichever currently selected point) to a 

curved line. 

 

Simplify 

 
Some library images or other imported images from other sources may 

contain a very large number of points.  The Simplify tool will automatically 
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re-adjust the imageôs points and simplify the image to its simplest possible 

point form while maintaining the imageôs original overall line form. 

 

Aside from the tools found in Point Edit Mode, there are two additional 

editing tools found on the left-hand side of the screen. 

 

Eraser Tool 

 
You may erase any part of any image using the Eraser tool to easily and 

immediately remove inner parts or edges of the line image.   

 

 

 

 

 

Original Image             New image using Eraser Tool 

 

Knife Tool 

 

You may segment images using the Knife tool.  This tool delivers a straight-

line cut to separate parts of images to create a new separate independent 

shape.  

 

 

 

 

 

 

 

Original Image         New images from using Knife Tool 

4.3 Line Tools 
Lines in the program, including text, images created using the drawing 

tools, and library images, may be altered to have different properties. 

 

Line Color Options 

 
While lines will default to be displayed in red, you may alter lines to any 

desired color.  Altering line colors will not affect their properties in how 

they may cut.  Altering line colors may be helpful to allow you to more 

easily view different images or image parts, see lines in whichever color 

you may prefer to view them, or adjust image parts specifically with 

printing in mind for Print & Cut jobs where it may be important that line 

colors are selected to be printed. 

 

To adjust line colors, select your image and access the Line Color menu by 

clicking on the icon shown above.  You may then select any of the Basic 

Menu color options.  The hash line selection will always represent ñclearò. 

The color picker tool will allow you to select any color from another object 

in the drawing area to duplicate the desired color. 

 

    
 Clear             Color Picker 

 

The Advanced Options menu will allow you to create lines in any desired 

custom color.  You may either drag the target on the color spectrum to 

visually match the color you are looking for, or type in the RGB (Red Green 

Blue) or HSL (Hue Saturation Lightness) value of your desired color.  You 

will also have the ability to adjust the Transparency of the line.  
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Line Style Options 

 
Within the Line Style menu, you may adjust the style of your line to be a 

solid (default) or dashed style line.  Lines will accordingly be cut or printed 

in the selected style. 

 

Lines are viewed in point sizes regarding their width.  The point size may 

be adjusted to any desired specification.  While line width may be adjusted, 

the line will always be cut or sketched in a fixed width; that is, according to 

how thick the blade or pen is that you are using.  The line styles are only 

really used in accordance with creating image effects for Print & Cut 

images. 

 

Line thickness may be adjusted by either manually dragging the Thickness 

option bar or by typing in the desired point thickness. 

 

The Corner Style option will adjust how lines appear at any of the imageôs 

corner points where Corner is a sharp edge whereas Rounded will be a 

smoother edge. 

 

The End Cap Style option will only adjust lines that have open ends. Flat or 

Square provide varying sharper flat edges at the line tip whereas Rounded 

provides a smoother rounded edge to the line tip. 

 

The Position option will adjust if the line is In Front of a filled image, or 

Behind the filled image. 

 

If you desire to send your document to a printer to print your images, the 

Print Lines of Selected Shapes option will enable all lines of selected images 

to be printed as they appear on the screen. 

 

Cut Style Options 

 
The Cut Style option may be selected at any time to view how each line or 

image on your workspace is set to be cut.   

 

When clicking on this option, your workspace will immediately emphasize 

all lines and their selected attributes for easy reference.  To change a lineôs 

cut style, simply click on the desired image and then select the new desired 

line style from the list.  The following line styles are available: 

 

No Cut ï This option will turn off the line from being sent to the 

Silhouette.  While you will still be able to see it on your screen, it will be 

suppressed from being cut. 

 

Cut Edge ï This option will cut the outer edge of any overlapping 

lines and will suppress any lines with the same attribute if they are 

contained inside a larger image.  This option may be preferable for the 

creation of Print & Cut images.  

 

Cut ï This option ensures the selected line will be cut regardless of 

where it is placed, whether overlapping or inside a larger image.  Lines with 

this attribute will cut even if they are contained within other lines that are 

defined as ñCut Edgeò or ñPerforate Edgeò line types. 

 

Perforate Edge ï This option will cut a dashed line on the outer edge 

of any overlapping lines and will suppress any lines with the same attribute 

if they are contained inside a larger image.  
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Perforate ï This option will cut the selected with a dashed line 

regardless of where it is placed, whether overlapping or inside a larger 

image.  Lines with this attribute will cut a dashed line even if they are 

contained within other lines that are defined as ñCut Edgeò or ñPerforate 

Edgeò line types. 

4.4 Fill Tools  
Closed images (where the starting point of the line connects with the ending 

point of the line) including Text, images created using the drawing tools, 

and library images, may be altered to have different filled properties.  Only 

closed images may have filled attributes.  If the path is broken on any 

closed images, any applied fill attributes will immediately disappear. 

 

Fill Color Options 

 
While closed images will default to be displayed as empty, you may fill any 

closed image with any desired color.  Altering fill colors may be helpful to 

allow you to more easily view different images or image parts, see shapes 

and text in whichever color you may prefer to view them, or adjust images 

specifically with printing in mind for Print & Cut jobs. 

 

To apply fill  colors, select your closed line image and access the Fill Color 

menu by clicking on the icon shown above.  You may then select any of the 

Basic Menu color options.  The hash line selection will always represent 

ñclearò. The color picker tool will allow you to select any color from 

another object in the drawing area to duplicate the desired color. 

 

    
 Clear             Color Picker 

The Advanced Options menu will allow you to create fill colors in any 

desired custom color.  You may either drag the target on the color spectrum 

to visually match the color you are looking for, or type in the RGB (Red 

Green Blue) or HSL (Hue Saturation Lightness) value of your desired color, 

if you are seeking a specific known color.  You will also have the ability to 

adjust the transparency of the filled color by manually dragging the 

Transparency option bar or by typing in the desired percentage of how 

transparent you wish the filled color to be, where 0% is solid and 100% is 

completely clear. 

 

Fill Gradient Options 

 
Similar to filling images with solid colors, you may also select to fill any 

closed line images with a gradient fill.  

 

To apply gradient fill options, select your closed line image and access the 

Fill Gradient menu by clicking on the icon shown above.  You may then 

select any of the Basic Menu pre-created gradient options.  The hash line 

selection will always represent ñclearò. 

 
 

You may also alter the basic direction of the gradient by clicking on any of 

the Direction options at the bottom of the Basic Options panel. 

 

The Advanced Options menu will allow you to create your own custom 

gradient fills based off of the last gradient fill selected. Gradient fills will 

always have a minimum of two (2) colors, with one color at the top and one 

color at the bottom.  The gradient will then create a range between the two 

selected colors.   
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You may change either of these colors in the range by clicking on the color 

arrow bars on the left-hand side of this gradient creator tool.  Once the color 

is selected, you may then select any new color from the Select Color tools 

directly below.  You may also add new bars at any interval between the top 

and bottom colors, or slide any color bars in between the top and bottom 

gradient color bars up and down to create new gradient effects. 

 

Also in the Advanced Options is the ability to rotate the angle of the gradient 

effect to any customized degree by either manually dragging the Angle tool 

or by typing in a specified degree.  You will also have the ability to adjust 

the transparency of the line by manually dragging the Transparency option 

bar or by typing in the desired percentage of how transparent you wish the 

filled gradient effect to be, where 0% is solid and 100% is completely clear. 

  

Fill Pattern Options 

 
The final fill option is used to fill any closed line images with a pattern fill.  

To apply pattern fills, select your closed line image and access the Fill 

Pattern menu by clicking on the icon shown above.  You may then select 

any of the pattern options.  

 

Once your desired pattern fill is selected, the Advanced Options menu will 

allow you to adjust the patternôs direction Horizontally or Vertically, or 

adjust to either a Fixed or Stretch aspect ratio.  Options are provided in this 

menu to rotate the pattern by either simple pre-set degrees, or to any 

customized degree by either manually dragging the Angle tool or by typing 

in a specified degree.   

 

In addition, you have the ability to scale the patternôs size to alter the 

pattern itself as it fills the selected shape.  You may do this by either 

manually dragging the Scale Pattern bar or entering a new percentage value 

of how much larger or smaller you may wish to make the filled pattern. 

 

You will also have the ability to adjust the transparency of the line by 

manually dragging the Transparency option bar or by typing in the desired 

percentage of how transparent you wish the filled gradient effect to be, 

where 0% is solid and 100% is completely clear. 

 

Additional patterns may be downloaded from the Silhouette Online Store. 

5. Text  
Silhouette Studio has the ability to utilize any TTF (True Type Font) that is 

installed on your computer.   You do not need to install these fonts into the 

program.  Silhouette Studio will simply access all installed TTF files and 

display them for you as you go to create your desired text. 

5.1 Creating Text  
To use your fonts, click on the text tool located on the left-hand side of the 

software screen: 

 
Clicking this will allow you to place a text cursor onto your workspace and 

begin typing directly onto the screen. 
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The red blinking line is your cursor to show where you are typing.  You 

may back up or move forward by either clicking your mouse or using your 

computerôs right and left arrow keys.   

 

The surrounding green box is your text box.  This box may be adjusted by 

clicking and holding the black bar on the right edge of the text box.  

Dragging this bar to the left will allow you to wrap your text. Dragging this 

bar to the right will allow you to bring text back toward being on a single 

linear path.  

 

You may double-click or click outside of the text to exit the Text Editing 

Mode.  You may return at any time to re-edit any words or letters by 

double-clicking again on your created text. 

5.2 Manipulating Text  
During the creation of your text, the Text Style menu will be opened on the 

right-hand side of your screen providing multiple adjustment options. 

 

Available Fonts 

The first section of this menu will display the current selected font with 

additional font options that are installed on your computer you may scroll 

through.  The top of this section may be used to search for any specific font 

by typing in a font name if it is known. 

 

You may change fonts during the Text Editing Mode and use a new font 

within the same text box with other fonts.  Different fonts may also be 

applied to existing text or letters during Text Editing Mode by highlighting 

the desired string and selecting the newly desired font.  If you are not in 

Text Editing Mode, new fonts may still be applied to selected text, but such 

adjustments will change the font for the entire selected text box. 

 

Font Characteristics 

Some fonts are programmed to enable the use of certain style characteristics 

allowing you to bold, italicize, or underline text or letters.  These 

characteristics will only be highlighted to be available for selecting if the 

font in question is programmed with that characteristic and such 

characteristics can be applied.  To apply one of these characteristisc, you 

may highlight the intended letters or words and then click on the available 

characteristc. 

  
While Bold, Italic, and Underline options are displayed, if there are any 

additional available options programmed for the selected font, a scroll bar 

will appear on the right-hand side of this option box allowing you to scroll 

down and view whatever other options may be programmed. 

 

Text Justification 

While text will be automatically be justified to the left, if your text is 

wrapped on multiple lines, you may alter your text justification as desired. 
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Text Size 

Text size will always default to 72 point size.  This refers to the fontôs 

printed font size.  Though fonts vary as they are programmed by a wide 

variety of sources, this will generally equate to roughly a one (1) inch 

height (or 25 mm).  The most common point sizes for print-format fonts are 

included in the available drop-down list, though any custom number may be 

manually typed into this size preference. 

 
Other common equivalent measurements in the list include: 

 

18 pt = 0.25 inch (6 mm) 

24 pt = 0.33 inch (8 mm) 

36 pt = 0.5 inch (13 mm) 

48 pt = 0.66 inch (17 mm) 

144 pt = 2 inches (50 mm) 

288 pt = 4 inches (100 mm) 

 

Again, these measurements are approximations and will vary from font to 

font, so if you are seeking to obtain a specific measurement, you may wish 

to alternately re-size your text to your desired specification after creation. 

 

Character Spacing 

Letters may be adjusted from their normally programmed spacing to either 

bring them closer together or push farther apart with the Character Spacing 

option. 

 
Spacing will always start at 100% indicating spacing between characters are 

normally distanced.  As the number is lowered or the bar is slid to the left, 

letters will come closer together.  As the number is raised or the bar is slid 

to the right, letters will become spaced farther apart. 

 

Line Spacing 

If your created text is wrapped to multiple lines, you may similarly increase 

or decrease the Line Spacing option to adjust the distance between lines of 

text. 

 
Spacing will always start at 100% indicating spacing of lines are normally 

distanced.  As the number is lowered or the bar is slid to the left, text lines 

will come closer together.  As the number is raised or the bar is slid to the 

right, text lines will become spaced farther apart. 

5.3 Text to Path  
As text is created, or while in Text Editing Mode, you will find a control 

point located on the left-hand side of the text being created: 

 

 
 

This control point may be dragged to rest directly on any line path within 

your workspace.  For example, you may create an oval with the Circle tool 

and then drag your text onto this line to achieve an arced effect: 
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As text is applied to a path in this manner, you will note a vertical bar to the 

left of the text.  This allows for a new control bar which can be used to 

adjust the placement of your text relative to the line onto which the text has 

been applied so that it may be placed on, above, in line with, or below the 

path. 

 

Note also that the object used as a path will turn grey.  This indicates that 

this image is now turned off for cutting purposes.  If you wish to re-enable 

the object being used as a path to cut, you may visit the Cut Style Options as 

previously discussed and select Enable Cut Style as the grey path object is 

selected. 

6. Manipulating Images  
There are many tools in Silhouette Studio allowing for basic and advanced 

manipulation of images and text.  The following section provides an 

overview for all of these included tools and how they may be used. 

 

6.1 Basics 
Like most any software program, Silhouette Studio has a set of common 

basic editing tools as follows: 

 

Selecting 

Images may of course be selected by clicking on them.  Multiple images 

may be selected by holding down the Shift key on your computer keyboard 

and clicking on another image.  You may repeat this action to select as 

many images as desired.  Holding down the Shift key and clicking on an 

image that is already selected will de-select that image. 

 

Multiple images may be also be selected by clicking above an image and 

dragging your mouse to enclose all desired shapes to be selected at the same 

time.  As you hold your mouse button down and drag your mouse, you will 

see a dashed line creating a selection box showing what you are selecting.  

Upon letting go of your mouse, all enclosed images in this box will be 

selected together in the same bounding box. 

 

 

 

If you wish to select all available images on the screen together, you may 

click on the Select All button located along the bottom of the software 

screen: 

 
Similarly, if you wish to deselect all currently selected images, you may 

click on the Deselect All button: 

 
Copy/Paste/Cut Tools 

 

These tools perform the basic expected actions of copying selected images, 

pasting them, or cutting them from view.  Images copied or cut will reside 

in your computerôs memory on a virtual clipboard.  You may only have one 

object on this clipboard at a time.  This means if you copy one image and 
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then copy another, only the most recent image will be waiting on the 

clipboard to be pasted.  These actions may be accessed from the top tool 

bar, in the Edit menu, or by right-clicking on an image, as well as by using 

standard shortcut keys for these actions. 

 

Pasting copied images will place the copy directly to the right of your 

original image so you may easily see and find your copy.  An additional 

Paste in Front option is also provided to be able to paste a copy of an image 

directly on top of itself and is found in the Edit menu, in the right-click 

menu for the selected image, or by using standard shortcuts for this action.  

 

Duplicate 

 

The Duplicate option performs the same action as copying and pasting the 

selected image to the side, but does so without the need of utilizing your 

clipboard and is a one-click operation.  This toolbar button is located along 

the bottom of the software screen and can alternately be located in the Edit 

menu or by right-clicking on a selected image. 

 

Delete 

 
Selected images may be deleted from your workspace by clicking on the 

Delete button located along the bottom of the software screen, by accessing 

the Edit menu and selecting Delete, right-clicking a selected image and 

choosing the Delete option, or by simply pressing the Delete key on your 

computer keyboard. 

 

Undo/Redo 

 

Any action taken, including simply moving an image, may be undone.  To 

back up to the previous action taken, click the Undo button.  There are an 

unlimited number of actions you may go back to with the Undo button, 

including going back to when you first opened your new workspace. 

Similarly, you may click the Redo button to repeat any actions you may 

have undone.  You may continue to use this button until you return to the 

last action taken. 

 

6.2 Grouping/Ungrouping  
These two actions are commonly used and are invaluable tools for helping 

to manipulate and adjust images.  To understand these concepts we must 

first understand what grouped and ungrouped images are. 

 

The following is an example of a single line: 

 
 

While the image may have many parts, it is still just one line with a single 

starting point and end point. 

 



   

 
26 

The following is an example of a multiple line image: 

 
This image has two line sets with the body of the leaf and stem being one 

part and the inner details of the leaf being another.  This image is grouped 

together so that if moved around on your screen, you do not have to move 

the outer line of the leaf and then move the center part independently and 

try to align it inside. 

 

While it is not necessarily important to know exactly how many line parts 

an image has, it is important to understand that single line images are not 

grouped together with anything, while anything that has multiple parts is or 

can be grouped. 

 

 

Grouping 

 
Any two sets of lines can be grouped together so they are fixed in their 

relative positions, even if moved, by using the Group option. 

 

To use the Group option, select two or more images at the same time and 

click on the Group icon located along the bottom of the software screen. 

This can alternately be located in the Object menu or by right-clicking on 

the multiple selected images and selecting Group. 

 

 

 

 

Ungrouping 

 
Any image that contains more than one line set can be ungrouped so that 

parts of the image may be treated independently, removed, rotated, resized, 

or otherwise manipulated rather than having to manipulate the image as a 

whole. 

 

For example, you may wish to cut out this cake image, but want to ungroup 

the image in order to remove some of the inner decorations of the image: 

 
 

Once ungrouped, the image will be displayed showing individual selection 

boxes around each new ungrouped image part that can now be manipulated: 
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To access the individual ungrouped parts, you may unselect your image and 

then click onto any independent desired part for further removal or 

manipulation. 

6.3 Compound Paths 
The concept of compound paths is important in order to understand why 

certain attributes may be applied differently to seemingly identical 

situations.  Compound paths are a collection of two or more line sets where 

inner lines are embedded into the image. A compound path may appear the 

same as a grouped set of lines, but is quite different in the way it will react 

to being filled with color, for example.   

 

Compound paths are only really a concern when you are creating Print & 

Cut images. 

 

 
      Non-compound image       Compound Path image 

 

In the examples above, the top two images are seen straight on and appear 

to be identical.  However, when looking at the bottom set of images the 

differences become apparent.  With the image on the left, from a side view 

we are actually looking at a grey circle with a set of eyes and mouth as three 

other separate white shapes resting on top.  This is an image that is not a 

compound path.  With the image on the right, from a side view we see that 

we are looking at a circle with two holes and a smile embedded into the 

image. 

 

Of course, as we go to cut or sketch both images with the Silhouette, they 

will cut out in the exact same manner, but it is important to understand that 

there is a difference between these images as you may wish to achieve 

certain effects with filling images for Print & Cut applications.  For 

example: 

 

 
 

This is the same image unfilled.  All parts are grouped together.   

 

If this is a non-compound image and it is filled with a color feature, this will 

be the result: 

 

 
 

Even though grouped together, all line sets are still just individual pieces 

lying on top of each other, so they are all filled with the selected fill effect. 

 

If this image has a compound path and it is filled with a color feature, this 

will be the result: 
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The unfilled parts of the image cannot be filled with compound path images 

because these embedded areas are negative space. 

 

Compound paths can still be ungrouped to move multiple image parts 

around, but the action of ungrouping will immediately release the 

compound path and make it a non-compound path image 

 

To make a series of multiple selected images a compound path, you may 

right-click until the multiple parts are all selected and select Make 

Compound Path.  Similarly, you may right-click on a compound image and 

select Release Compound Path to perform the opposite action.  These 

options may also be found in the Object menu. 

6.4 Moving Images 
Images may obviously be moved by selecting them and then dragging them 

around the screen with your mouse to any desired location.  Selected image 

may also be moved by using the arrow keys on your computer keyboard. 

 

You may also move images through the Move menu panel. 

 

Selected images may be moved by using any of the Move options.  The 

directional arrows in this screen will move images subtly in whichever 

direction you select.  This action may be repeated until your image is 

located on your workspace as desired. 

 

The Move By option will move selected images from the current location by 

whatever measurement is entered, while the Move To option will move 

images regardless of present location to a specific plotted course on your 

workspace, where a measurement of 0, 0 (zero, zero) represents the upper 

left-hand corner of your workspace and moves out from that point either to 

the right or downward as the values increase. 

6.5 Rotating  
Objects may be rotated to any desired angle.  Selected images will always 

appear with a green rotation handle-bar that may be manually grabbed and 

rotated using your mouse. 

 
 

The Rotate menu options will also provide additional rotation options for 

more exact or specific rotation options. 

 
Within the Rotate menu you may select any of the following options. 

 

Rotate By 

These options will rotate the selected image by the selected common angle 

from the imageôs current angle. 

 

Rotate To 

These options will rotate the selected image to the selected angle based on 

the imageôs original fixed 0° point. 

 

Custom Rotate By 

This option will allow you to either manually slide a degree measurement 

bar or enter a specific degree measurement and apply to rotate the selected 

image from the imageôs current angle. 
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Custom Rotate To 

This option will allow you to either manually slide a degree measurement 

bar or enter a specific degree measurement and apply to rotate the selected 

image based on the imageôs original fixed 0Á point. 

6.6 Sizing 
Objects may be sized to any desired measurement.  It is important to note, 

however, that while you may customize images to any desired size, the 

quality of cuts made may vary, especially when cutting thicker materials 

such as cardstock. Reducing the size of an image with intricate parts and 

cutting it in a thicker material is an example where the cut quality could 

suffer. 

 

You will be able to view the measurement alongside your image as you 

draw or select images. 

 
There are also control points on the selection box for resizing images 

manually.  To resize manually, simply click on any of these boxes and drag 

your mouse in the desired direction to make your shape larger or smaller.  

The corner control points will proportionately resize the image and maintain 

the relative height and width, while the side control points will stretch your 

image in the direction your mouse is dragged. 

 

The Scale menu options will also provide additional sizing options for more 

exact or specific rotation re-sizing options. 

 
Within the Scale menu you may select any of the following abilities. 

 

Scale 

These options will resize any selected images by a percentage of its current 

size.  Any number under 100% will make your image smaller and any 

number over 100% will make your image larger.  For example, selecting to 

resize your image to 50% of the current size will make your image half as 

large while selecting to resize your image to 200% of the current size will 

make your image twice as large.  Any custom percentage may be applied as 

desired. 

 

 

Specify Dimensions 

This option will allow you to resize a selected image to any specific 

measurement.  The Lock Aspect Ratio option when checked will ensure your 

image is resized proportionately when only one measurement is being 

altered but you wish to maintain the imageôs proportions.  For example, if 

we take our original leaf example that started at 1 inch height by 2 inches 

width and adjust the width to 1 inch, you can see the following results: 

 

 

 

 

 

 

 

 

 

              With Lock Aspect Ratio    Without Lock Aspect Ratio 
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Grid 

To assist with viewing measurements, you may also opt to turn on the grid 

by either right-clicking on your workspace while there are no images 

selected and clicking on Show Grid, or by going to the Grid menu. 

 
In the Grid menu you may turn the grid on and off, adjust the grid spacing to 

any desired measurement, and define the number of divisions in the grid. 

 

 

 

 

 

                 Single Division                                          Multiple Sub-Divisions 

 

The Snap to Grid option when enabled will force the image to conform to 

gridôs measurement and divisions.  This may be especially helpful when 

drawing images to force them to conform to specific desired measurements. 

 

The gridôs Style may be selected to be either a traditional Square grid or an 

Isometric grid.  Again, the different styles may be helpful while drawing 

images within the software to provide a reference for measurement as you 

draw. 

 

 

 

 

 

 Square Grid                Isometric Grid 

 

The gridôs Color can also be adjusted as desired and offers a pre-selected set 

of color suggestions which may provide a non-intrusive appearance for your 

grid, though any custom color may of course be selected.  

6.7 Mirroring  
Some materials or situations require images to be cut in a mirror image 

format, or you may simply want to flip objects around to achieve your 

desired image appearance. 

 

To mirror an image, you may right-click any selected image to select the 

Mirror Horizontally or Mirror Vertically option. 

 

              No Mirror Effect                                   Mirrored Horizontally 

 

           

 

 

                         

 Mirrored Vertically                     Mirrored Horizontally & Vertically 

 

Further mirroring options may be accessed in the Object menu under the 

Transform sub-menu listed as Mirror Options. 

 

In this menu, you may likewise flip your images around (as displayed 

above) under the listed Flip menu options. 

 

You may additionally create mirror copies of selected images with the 

Mirror menu options, where you may create a mirrored copy to the left, to 

the right, mirrored above, or mirrored below. 

            
       Original Image 
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                      Mirror copy Left                                            Mirror copy Right 

                                       
                   Mirror copy Above             Mirror copy Below 

 

6.8 Arranging  
Multiple images may overlap each other.  The order of which image is in 

front and which is in back can be arranged.  This is mostly used with filled 

images for Print & Cut applications so you can determine which image 

should be in front of the other.   

 

Bring to Front 

 
This option will take your selected image and move it in front of all other 

overlapping images.   

 

 

 

 

 

 

             Original Image Order              Circle selected and Brought to Front 

 

Send to Back 

 
This option will take your selected image and move it behind all other 

overlapping images. 

 

                    

 

 

 

 

                 Original Image Order               Triangle selected and Sent to Back 

 

In addition to these options, you may also right-click on an image and select 

Send Backward to send the selected image one level back rather than all the 

way to the back. 

 

             

 

 

 

 

           Original Image Order              Triangle selected and Sent Backward 

 

Similarly you may right-click on an image and select Bring Forward to 

bring the selected image one level forward rather than all the way to the 

front. 

 

             

 

 

 

 

               Original Image Order                   Circle selected and Brought Forward 
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6.9 Aligni ng 

 
Multiple images may be aligned in relation to each other.  The following 

Align options are available: 

 

Centralize (Align Center-Middle)  

 
This option will center two or more selected objects so that they are lined 

up with each other in the middle of each other. 

 

Align Left 

 
This option will align two or more selected objects so that they are aligned 

together to the left edge of the shared bounding box while maintaining their 

respective distances in regard to being above or below each other. 

 

Align Center 

 
This option will align two or more selected objects so that their center 

points are aligned together while maintaining their respective distances in 

regard to being above or below each other. 

 

 

Align Right 

 
This option will align two or more selected objects so that they are aligned 

together to the right edge of the shared bounding box while maintaining 

their respective distances in regard to being above or below each other. 

 

Align Top 

 
This option will align two or more selected objects so that they are aligned 

together on the top edge of the shared bounding box while maintaining their 

respective distances in regard to being next to each other. 

 

Align Middle 

 
This option will align two or more selected objects so that their center 

points are aligned together while maintaining their respective distances in 

regard to being next to each other. 
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Align Bottom 

 
This option will align two or more selected objects so that they are aligned 

together on the bottom edge of the shared bounding box while maintaining 

their respective distances in regard to being next to each other. 

 

Space Horizontally 

 
When a minimum of three objects are selected, this option will take all 

images and space them horizontally so that all objects are equidistant from 

each other horizontally. 

 

Space Vertically 

 
When a minimum of three objects are selected, this option will take all 

images and space them vertically so that all objects are equidistant from 

each other vertically. 

 

 

 

 

6.10 Replicating  

 
Replicating while similar to copying and pasting an image or duplicating it 

allows for the ability to create any number of copies and place them at once 

without the need to copy and paste the images multiple times and then have 

to place them manually around the screen as desired.  These options will 

also create copies next to each other as closely as possible to maximize your 

cutting area. 

You will find the following options in the Replicate options basic menu. 

 

Duplicate Left 

 
This option will duplicate the selected object and place a copy directly to 

the left with the most minimal amount of space between the objects as 

possible. 

 

Duplicate Right 

 
This option will duplicate the selected object and place a copy directly to 

the right with the most minimal amount of space between the objects as 

possible. 
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Duplicate Above 

 
This option will duplicate the selected object and place a copy directly 

above with the most minimal amount of space between the objects as 

possible. 

 

Duplicate Below 

 
This option will duplicate the selected object and place a copy directly 

below with the most minimal amount of space between the objects as 

possible. 

 

Row of Three /   Row of Four 

 
These options will copy the selected object and replicate two or three 

additional copies next to each other in a row, stacked horizontally next to 

each other, with the most minimal amount of space between the objects as 

possible. 

 

Column of Three /  Column of Four 

 
These options will copy the selected object and replicate two or three 

additional copies next to each other in a column, stacked vertically on top of 

each other, with the most minimal amount of space between the objects as 

possible. 

 

Rotate One Copy /  Two Copies /  Three Copies /  Five Copies 

 
These options will copy the selected object and replicate one through five 

rotated copies on top of the original image. 

 

Fill Page 

 
This option will copy and replicate the selected object and fill the cutting 

area with as many copies possible. 

 

In the Replicate menu, you may also access an Advanced Options menu.  

Here you will have the option to select any desired number of copies to 

replicate your selected image and the distance between these replicated 

images, including the ability to select any custom direction.  Once the 

desired number of copies and direction has been selected, you may click on 

the Replicate button at the bottom of the Advanced Options menu to apply the 

selected attributes. 

6.11 Welding & Modify Options  
Overlapping images may be altered in a variety of ways.  The Modify menu 

options provide welding and other advanced options to allow overlapping 

images to be adjusted. 
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Within the Modify menu you may select any of the following abilities. 

 

Weld 

 
While the Weld option may be found in the Modify menu, there is also a 

quick access button located along the bottom tool panel of the software 

screen.  Welding will take two or more selected overlapping images and 

join them together into one single continuous image. 

              
                       Non-welded image with overlapping lines 

              
                    Welded image with overlapping lines removed 

 

Welding can be particularly useful when cutting so that the cut lines donôt 

overlap during the cutting process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Intersect 

 
This option will leave only the overlapping part, or intersecting part, of the 

selected images when applied. 

 

 

 

 

 

 

 

           Original Images                          With Intersect Applied 

 

Subtract 

 
This option will remove all overlapping parts of images that are in front of 

other images, so that only the image located in back will remain with the 

overlapping parts removed. 

 

 

 

 

 

            Original Images                                With Subtract Applied 
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Crop 

 
This option will remove all areas that are not shared by at least two shapes 

when overlapping. 

 

 

 

 

 

Original Images          With Crop Applied 

 

 

Subtract All 

 
This option will remove any portion of an image that is in back behind 

another image.  

 

 

  

 

 

 

                   Original Images                              With Subtract All Applied 

 

 

 

 

Divide 

 
This option will create individual images from the intersections of up to 

eight selected images. 

 

 

 

 

 

 

 

             Original Images                            With Divide Applied 

 

 

Detach Lines 

 
When images are filled or have thick lines defined, this option may be used 

to detach and move the outline to create two separate images; one with just 

the lines and one with just the filled effects left behind. 

 

Compound Paths (Make / Release) 

 
These options are the same options previously discussed in the section 6.3 

regarding Compound Paths.  This tool will take overlapping embedded 

images and either Make them into a compound path or Release the 

compound path. 
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6.12 Offset Options  
The Offset option may be used to outline cut-line images giving the image a 

shadowed mat effect underneath it.  It may also be used to create contoured 

inner lines for images.   

 
To apply offset conditions, you will first need to select an image. 

   

 
       Original Starting Image 

 

Within the Offset menu you may start by selecting the offset action: 

 
You may select to either have your offset image have a sharper Corner 

appearance, or have a softer more bubbly Round appearance. 

 

Though clicking the offset action button provides a starting point, you may 

fine tune the offset effect to any specified Offset Distance with the slider bar, 

or by typing in a specific measurement.  

 

At any point your desired effect is achieved you may set the properties of 

the newly created image into place by clicking Apply. 

 
             Offset Image 

 

You may conversely create an internal offset condition. 

 
This feature is generally better suited for the creation of internal lines for 

use with sketch pens. 

 

    Internal  Offset Image 

6.13 Tracing  Options  

 
Tracing options can be used to automatically trace imported external images 

for the purpose of creating cut lines.  Silhouette America cannot guarantee 

the quality of images not created by our company nor support any third-

party images not offered through the Silhouette Online Store.  Silhouette 

Studio should not be used to trace licensed or copyrighted images which 

you do not specifically own.   

Once you have opened an external image you own (as discussed in Section 

3.4), you may open the Tracing options and then click on Select Trace Area.  

This will allow you to draw a box around the intended area of your 

imported image you may wish to trace.  This selection area once drawn may 

be adjusted or moved like any other object in the program as you may need 

to expand or refine the trace area.  The trace area selection will provide a 

preview of the original image with a yellow area overlay where the trace 
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area would be applied according to the Trace Settings filters.  These filters 

will provide a more refined or more liberal application of the intended 

traced effect depending on the settings selected. 

Once the desired tracing effect preview is achieved, you may then opt to 

apply the trace method by selecting one of the following: 

Trace ï This option will provide a traced line contour around all parts of the 

yellow preview area displayed.  

Trace Outer Edge ï This option will create a traced line around the outer 

edge of the yellow preview area displayed only and ignore any inner parts 

that may otherwise be displayed in yellow showing a potential tracing path. 

Trace and Detach ï This option will trace the outer edge of the yellow 

preview areas of the image and detach them from the rest of the background 

of the raster image. 

7. Library and Online Store  
Silhouette Studio offers a library feature to keep and categorize all of your 

downloaded and user-created image for easy reference, as well as an online 

store to provide new content for users to download. 

The library and store views may be found on the left-hand side of software 

screen and show which panel (workspace, library, or store) is the current 

selected active panel. 

 

7.1 Library  

 
The library is where all of your pre-loaded and purchased content is 

contained and may be categorized, sorted, and accessed. 

 

Viewing 

You will be able to either view your images as icons by clicking on the Icon 

View option: 

 

 
 

Library in Icon View mode 
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You may alternately view your library images in a list view to see more 

detail by clicking on the List View option: 

 

 
 

Library in List View mode 

In List View mode you may sort your images by Name, Category, Artist, Date 

Downloaded, or Size by clicking on these column header titles. 

 

In addition to how you view your library content, you also have the ability 

to adjust how your library is viewed as to whether you are viewing the 

library only or if you are viewing the library and your workspace.  You will 

find these viewing options on the left-hand side of the software under 

library and online store buttons. 

 
 

The top icon showing only one panel will display only your library or 

online store as they are accessed: 

 
 

While the bottom icon showing two panels will display your library or 

online store along side your workspace: 
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Accessing Library Content 

To access libray images, you may: 

 

¶ Double-click on your image to open it onto your workspace 

¶ Drag images from your library onto your workspace (only if your 

workspace is being displayed) 

 

Categorizing & Library Management 

As your library continues to grow with additional content, you may find it 

convenient to customize your library with new folders and sort images 

according to your liking. 

 

You may add new custom folders by clicking on the Add Folder icon. 

 
As new Untitled Folders are created, you may immediately name your folder 

to the desired name.  Once your new folder has been created, you may drag 

and drop images into the folder.  Right-clicking on a folder will allow you 

to create a new sub-folder for that selected folder, delete the folder (along 

with all contained content), or rename the folder. 

 

In addition to customizing folders, you may also adjust any of your images 

within the library.  Right-clicking on an image will allow you to delete the 

image, re-name the image, sort the images in the current folder, or 

show/hide the images properties.  Image properties will provide you with 

the imageôs description (as downloaded from the online store) and display 

any associated keywords. 

 

As images or folders are deleted, they will be moved into the libraryôs 

Recycle Bin.  You may still restore any of these images or folders by 

dragging them back into your library.  However, once you have deleted any 

content from your Recycle Bin, this content will be permanently deleted from 

your computer. 

7.2 Online Store  

 
The Silhouette Online Store provides additional downloadable content from 

not only Silhouette America, but also a variety of independent artists and 

contributing companies.  The Silhouette Online store can only be accessed 

from within the Silhouette Studio software and requires an Internet 

connection.  

 

The Silhouette's "Purchase Online" shopping section is accessible at any 

time, 24 hours a day, 7 days a week. 

 

While images may be purchased individually to customize your library 

experience, subscription options are also available for a monthly fee. 

Further information on subscriptions may be found in the Silhouette Online 

Store.  
 

All images are provided with the following benefits: 

 

¶ You may download images using any major credit card, through 

download cards, or by using subscription credits 

¶ Indefinite usage (you do not have to be connected to the Internet to 

access once purchased) 

¶ Recoverable (in case of computer crash or replacement) 

¶ Resizable and customizable to your specifications (using Silhouette 

Studio tools discussed in previous sections) 

 

Download Cards 

Silhouette America offers download cards which provide download credit 

valid toward any of the storeôs download content you may wish to purchase 

and add to your library.  You will find two codes on the back of each card. 

In the lower right-hand corner is the card's identification number. Behind 

the silver security strip is the actual download code. It is a 16-digit code. 
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Logging into the Store 

Upon accessing the Silhouette Online store by clicking on the Silhouette 

Online Store button, you will be brought to the storeôs homepage. 

  

You may sign in, or sign up for an account if you do not already have one 

created, by clicking on the link in the upper right-hand corner noting that 

ñYou are not signed inò. 

To create an account, you will need to provide your name, your email 

address (which will be your log-in name), and any desired password.   

 

My Account Options 

Once logged into your account, you will find a link in the upper right-hand 

corner called My Account which will provide you with tools to manage your 

account.  You will have the following options: 

 

¶ Change My Account Information ï This will allow you to alter your 

email and password.  

¶ My Download History ï This will allow you to view a copy of all 

orders placed.  When viewing specific orders, you may also opt to 

recover a specific order if there was any break in connection 

during the download process. 

¶ Recover All Downloaded Designs ï This will allow you to recover 

any and all previously downloaded content if you are seeking to 

load the software onto a new computer in the case your computer 

has crashed or you are simply replacing your computer.   

¶ Add a Download Card to My Balance ï This is where you may enter 

any download card codes to apply the available balance onto your 

account.  

¶ Manage My Credit Cards ï Allows you to manage any credit card 

information on file used to pay for subscriptions or individual 

purchases. 

 

Shopping 

You are free to browse all available Silhouette images without any 

obligation to purchase. You will find a navigation aide on the left-hand side 

of your shopping window.  As categories are selected or as you search for 

images, you will also find related suggestions listed. 

 

For specific images you are looking for, you may search for specific image 

names or terms in the upper right-hand corner: 

 
 

As you browse through the different themes and releases or make specific 

searches, once you find an image you would like to download, you may 

either add it to your cart by clicking on the add to cart option: 

 
 

 


